
OV/400 to Domino:

A Migration & Coexistence Roadmap

This is a working document and will be updated often.   
You will find the most current version of this document at:

http://www.ibm.com/support/techdocs 

We do welcome your input and feedback! Please forward  
comments to:

Internal:  Joan Finney/Roanoke/IBM@IBMUS

Internet: finney@us.ibm.com



286.8.2 Updating the LCCOV/400 Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
276.8.1 If you did not remove OV/400 enrollment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
276.8 Miscellaneous Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
256.7 Re-enabling Directory Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
246.6 Removing OV/400 Enrollment for migrated users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
246.5 Migrating Data from OV/400 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
236.4 Registering OV/400 users to Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
21

6.3 Removing the OV/400 Calendar Domain for users who will migrate to
Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

216.2 Suspending Directory Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
206.1 Defining name collision handling during registration . . . . . . . . . . . . . . . . . . . . . . . . . . . .
206.0 Migrating a Set of Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
19Step 11: Loading distribution lists and public nicknames . . . . . . . . . . . . . . . . . . . . . . . .
19Step 10: Extracting distribution lists and public nicknames . . . . . . . . . . . . . . . . . . . . . .
19Step 9: Repeat steps for each subset of SDD entries . . . . . . . . . . . . . . . . . . . . . . . . . . . .
17Step 8: Correcting short name collisions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
17Step 7: Finding collisions on Short Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
16Step 6: Extracting working subset of SDD entries again . . . . . . . . . . . . . . . . . . . . . . . . .
16Step 5: Correcting full name collisions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
15Step 4: Removing acceptable entries from mignames.nsf . . . . . . . . . . . . . . . . . . . . . . . .
14Step 3: Finding full name collisions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
14Step 2: Extracting a subset of SDD entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
14Step 1: Selecting a subset of SDD entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
135.2 Using DME/400 to Identify and Resolve Name Collisions . . . . . . . . . . . . . . . . . . . . . . . .
125.1.3 Extracting and loading users, distribution lists and nicknames . . . . . . . . . . . . . . .
115.1.2 Selecting OV/400 users for loading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
105.1.1 About Mignames.nsf . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
105.1 Understanding and planning for name collisions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
105.0 Resolving Name Collisions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
94.4 Installing DME/400 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
94.3 Installing the OV/400 Extraction Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
84.2 Installing and Configuring LCCOV/400 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
74.1 Verifying Completeness of SDD Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
74.0 Preparing your AS/400 Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
53.0 Planning for Migration and Coexistence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
42.0 Process Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
21.2 Related Publications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11.1 Products . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11.0 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



1.0 Introduction

Several IBM tools and functions are available to help with migrating OfficeVision/400 users and
their data to Domino for AS/400. Since migration is rarely accomplished overnight or even over a
weekend, additional tools are available to help Notes and OV/400 users coexist effectively in your
enterprise. Many of the tools make extensive use of the information about your users that’s
available in the AS/400 system distribution directory and the Domino Directory (also known as
the Public Address Book or Name and Address Book.) At first glance, it is difficult to determine
exactly how each of the tools uses the information in your system and server directories and
whether it’s possible to satisfy all the needs of the various tools simultaneously. 

This document recommends a process for using various migration and coexistence tools to
successfully migrate OV/400 users to Notes and Domino on AS/400.  By following the
process documented here, you can migrate users to Notes while ensuring that OV/400 users
and Notes users can continue to exchange mail and view each other's calendars.  It is
important to note that not all network configurations and coexistence scenarios have been tested.
Therefore, modifications for your particular environment may be necessary.  The information
contained in this document has not been submitted to any formal IBM test and is distributed AS
IS.  

1.1 Products

The IBM OfficeVision to Lotus Notes Migration Tools for AS/400 Version 2 (5769-F08)
components and the components of several other products are used to establish a workable
system environment:

� OV/400 Extraction Tool: for selecting and preparing OV/400 user information and data for
migration to Domino. This is a component of the IBM OfficeVision to Lotus Notes Migration
Tools for AS/400 Version 2 (5769-F08). It must be installed on each AS/400 system that has
OV/400 users you plan to migrate.

� Domino Migration Engine for AS/400 (DME/400): for completing the migration of
OV/400 users and data to Domino for AS/400. DME/400 utilizes Domino server functions to
migrate data and register users that have been prepared by the OV/400 Extraction Tool.
DME/400 is a component of the IBM OfficeVision to Lotus Notes Migration Tools for
AS/400 Version 2 (5769-F08). It must be installed on a Domino for AS/400 server in the
same domain as the Domino server to which you are migrating users.

�  Lotus Calendar Connector for OfficeVision/400 (LCCOV/400): for allowing OV/400 and
Notes users to share calendar information and schedule meetings with each other. This will
help smooth the way for your users until the migration to Domino is complete. LCCOV/400 is
a component of the IBM OfficeVision to Lotus Notes Migration Tools for AS/400 Version 2
(5769-F08).  LCCOV/400 must be installed on a Domino for AS/400 server. 
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� Domino for AS/400 directory synchronization: for coordinating the information in the
AS/400 system distribution directory with the information in the Domino Directory on a single
system. Properly using directory synchronization greatly simplifies the process for setting up
and using LCCOV/400. Directory synchronization is a function of Domino for AS/400. 

� AS/400 directory shadowing: for coordinating the information in the AS/400 system
distribution directory (SDD) across all of the AS/400 systems in your network. Both
DME/400 and LCCOV/400 use the AS/400 system distribution directory (SDD) extensively
to identify OV/400 and Notes users and as a source of information about the users on your
AS/400 systems. AS/400 directory shadowing is a function of OS/400.

1.2 Related Publications 

This document is intended to supplement the specific product documentation that exists for each
product being used.  It will assist you in using the products and their documentation in a  
coordinated manner to tailor a mixed OV/400 and Notes environment that meets your needs.
You should refer to the following related publications for details on steps that are listed in this
guide:

� For more information about Lotus Domino refer to the Lotus Domino Administration
documentation or the HELPADMN.NSF database.

� For more information about Domino for AS/400, including directory synchronization, refer to:

Installing and Managing Domino for AS/400 Help or the AS400HLP.NSF database.  This is
shipped with Domino for the AS/400.

Domino for AS/400 Installation, Customization, Administration (SG24-5181) which can be
obtained from the  following Web site: http://www.redbooks.ibm.com

Domino for AS/400 4.6.3 Release Notes or the READAS4.NSF database.  This is shipped
with Domino for the AS/400. 

� For more information about shadowing the AS/400 system distribution directory:

SNA Distribution Services (SC41-5410)

� For more information about APPC communications configuration, refer to:

Communications Configuration (SC41-3401)

� For more information about the OV/400 Extraction Tool, refer to:

IBM OV/400 Migration Tools  or the IBMTOOL4.NSF database.  This is shipped with the
Version 2 Migration Tool.

� For more information about DME/400, refer to:

Domino Migration Engine Install or the LMTKINST.NSF database. This is shipped with
Version 2 Migration Tool.
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� For more information about LCCOV/400, refer to:

Installing and Managing LCCOV/400 or the LC400DOC.NSF database. This is shipped with
the Version 2 Migration Tool

� For more information about OV/400, refer to:

Planning for and Setting Up OfficeVision/400 (SH21-0695)

Managing OfficeVision/400 (SH21-0669)

Using OfficeVision/400 (SH21-0697)

� For more information about AS/400 CL commands, refer to: 

CL Reference (SC41-5722)

The AS/400 books can be accessed at the following Web site:

http://as400bks.rochester.ibm.com/
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2.0 Process Overview

Setting up and using the migration and coexistence tools consists of the following major steps:

1. Understand and plan for your migration and network requirements

2. Prepare your AS/400 systems for migration and coexistence

This includes verifying the completeness of the information in your AS/400 system
distribution directories (SDD) and installing and configuring all of the necessary software.

3. Identify and resolve name collisions

That is, ensure that each of your newly migrated Notes users will have a unique short name
and full name in the Domino Directory 

4. Migrate users and their data
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3.0 Planning for Migration and Coexistence

It is very important to thoroughly plan and prepare for migrating your OV/400 users to Notes.
You should become familiar with the documentation for each of the tools you plan to use.  Each
tool will have its own planning considerations. 

Here are some of the questions you should consider and information you should gather before
starting the migration process:

1. What does your OV/400 configuration look like today?  

� Do you have OV/400 users on more than one AS/400 system?

� Are you likely to have more than one OV/400 user with the same name or user id?

� Are you already using AS/400 directory shadowing to update the SDD entries on the
various systems? If so, what is the shadowing structure and schedule?

� If you already have many Notes users, are any of them likely to have a short name which is
the same as the user ID of one of your OV/400 users? Are any of the Notes users likely to
have the same full name as one of your OV/400 users? 

2. What does your Notes network look like today?

� How many Domino servers do you have and how many mail domains?

� Do you already have Notes users on an AS/400 system communicating with OV/400
users?

� Are you already using Domino for AS/400 directory synchronization to synchronize
entries in the AS/400 SDD with entries in the Domino Directory?

� How are directory entries replicated with other Domino servers and on what schedule?

� What are the mail routing schedules and connections?

� How many users are already registered on the Domino server?

� Do you have any users who are currently registered as both OV/400 and Notes users? 

3. What will your network configuration look like when you have completed all migrations to
Domino?

4. In what order will you migrate your OV/400 users?  

� How will you subset users for migration? Using the tools will be easier if you work with a
manageable and easily identifiable subset of your users at a time. For example, all of the
OV/400 users on system X and in a selected department.

� Do you have entries for users in your AS/400 SDD that should not be migrated to Notes? 

OV/400 to Domino:
A Migration & Coexistence Roadmap

5



� Do you have entries in your AS/400 SDD that should not be changed when you set up
calendar sharing with LCCOV/400?

5. What intermediate configurations will your network have during the migration process?  

� How long will these intermediate configurations last (1 week, 1 month, 1 year, etc.)?

� What requirements will you have during this time for exchanging mail and sharing
calendars between Notes and OV/400 users? 

6. How will your AS/400 systems be set up for migration?  

� Will you be migrating users to a Domino server on the same AS/400 where you are
currently running OV/400 or to a Domino server on a different AS/400?  

� Will you be migrating OV/400 users from several different AS/400 systems?  

� Will you be migrating OV/400 users to several different Domino servers or to only one? 

� Where will you install LCCOV/400?  See Installing and Managing LCCOV/400 database
(LC400DOC.NSF) for more information.

� Which AS/400 system(s) will be used as your DME/400 migration server? 

� Will any users migrating to Notes still require OV/400 enrollment?

After reading this document you should prepare a plan for migrating OV/400 users to Domino
while maintaining mail exchange and calendar access for users as needed. It might be helpful to
sketch a diagram of your network showing user and software requirements.  You will need details
on the following topics so that you can plan appropriately for installing software on your systems:

� the roles of each of your AS/400 systems before, during and after migration  

� the mail exchange and calendar sharing needs of your users before, during and after migration
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4.0 Preparing your AS/400 Systems

In order to prepare for migration, verify the entries in your AS/400 system distribution directory
and install the required software on the appropriate AS/400 systems. 

4.1 Verifying Completeness of SDD Entries

The system distribution directory on each of your AS/400 systems contains an entry for each
OV/400 user. The information in that entry is used extensively by many of the functions you will
use to accomplish migration and coexistence. You can make the process go much more smoothly
if you ensure that the information is complete before you start.

Make sure that each of your OV/400 users are fully described in the system distribution directory
(SDD) on each of your AS/400 systems. Use the Work with Directory Entries (WRKDIRE)
command to view and update the entries.

Here are some things to keep in mind:

� Each SDD entry for an OV/400 user should contain a value for First name (FSTNAM) and
Last name (LSTNAM) and optionally a Middle initial (MIDNAM).  

The autoenroll feature of OV/400 does not set these name fields so it is possible that these
fields are not set in the SDD.  After migration, users will be known to Notes by a "constructed
full name" that the OV/400 extraction tool creates by concatenating the First name, Middle
initial, and Last name values from the SDD entries. 

� Every “key mapping field” defined for directory synchronization must also be filled in.

By default, Domino for AS/400 directory synchronization uses the First name and Last name
as key mapping fields. If one or more of the key mapping fields are not filled in, the entry will
not be synchronized. That is, directory synchronization will not automatically create an entry
in the Domino Directory for that user entry. 

Directory synchronization allows you to define additional key mapping fields if necessary to
uniquely identify each of your users. For example, if you have several people named “John
Smith” in your network, you may want to also define Middle initial as a key mapping field.
Your Domino administrator and your AS/400 administrator should work together to
determine what to use for key mapping fields. You should have enough key mapping fields so
that when they are combined, they will uniquely identify users in your network.

If you decide that you will need additional key mapping fields to uniquely identify your users,
make sure that each of the key mapping fields is filled in for each entry in the SDD.

As part of installing and configuring LCCOV/400, you will be directed to set up Domino for
AS/400 directory synchronization if you are not already using it. If you are already using
directory synchronization, you will be directed to modify the configuration. You can define or
modify the key mapping fields at that time.  

OV/400 to Domino:
A Migration & Coexistence Roadmap

7



� Fill in other optional fields in the SDD entry (such as, Department, Location, Telephone
number, etc.) to fully describe each user.  Using the Department or Location field in the SDD
is very helpful for subsetting groups of users to migrate.

The information you provide now will be used by directory synchronization to create an entry
for each user in the Domino Directory. The more information you have available in the
Domino Directory to identify each user, the easier it will be for you to distinguish between
similar entries. This will be important in a later step.

4.2 Installing and Configuring LCCOV/400 

It is best to install and configure LCCOV/400 on one of the Domino for AS/400 servers in your
network before you begin migrating users to Notes.  Installing LCCOV/400 is a complex process,
but if you complete this step now, your users will be able to exchange mail and calendar
information with OV/400 users immediately after migrating to Notes, avoiding frustrating delays.
Refer to Installing and Managing LCCOV/400 database (LC400DOC.NSF) for more
information.

During the installation and configuration of LCCOV/400 you will:

Plan for the installation of LCCOV/400 on a Domino for AS/400 server

Prepare your Network and ensure that the users in your network can exchange mail. You will
perform the following steps:

� Set up and start SMTP MTA for the Domino server

� Configure the necessary APPC connections and SNA Distribution Services information

� Ensure you have the necessary system distribution directory entries for the local and remote
users in your network.

� Verify mail connections between all systems for a set of test users which includes both
OV/400 and Notes users.

Install LCCOV/400 and set up calendar sharing for OV/400 and Notes users. You will perform
the following steps:

� Install LCCOV/400 on the AS/400 from the CD.

� Automatically synchronize the AS/400 system distribution directory with the Domino
Directory using a new naming style which is optimized to support calendar sharing with
LCCOV/400.

� Add LCCOV/400 to the Domino server

� Reverify mail connections between OV/400 and Notes users since the naming style was
changed in the system and server directories.

� Set up calendar sharing with LCCOV/400 

Perform final configuration steps necessary for calendar sharing.
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� Start calendar sharing with LCCOV/400
  

4.3 Installing the OV/400 Extraction Tool

Install the OV/400 extraction tool on each of the AS/400 systems from which you are migrating
OV/400 users.  This tool gathers information about users from the SDD and collects OV/400 data
that will be migrated to Notes.  Refer to IBM OV/400 Migration Tools database
(IBMTOOL4.NSF) for information on installing and using the OV/400 extraction tool. 

4.4 Installing DME/400

Install the Domino Migration Engine (DME/400) on the Domino for AS/400 server that will be
used as your migration server.  The migration server must be in the same domain as the Domino
server to which you are migrating users.  Refer to Domino Migration Engine Install  database
(LMTKINST.NSF) for information on installing and configuring DME/400.
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5.0 Resolving Name Collisions  

5.1 Understanding and planning for name collisions

If you have a large network of OV/400 and AS/400 systems, you might have name collisions
when you attempt to migrate users to a single Domino Directory.  On a smaller network, or one
in which you have been very careful about unique naming for all users,  you might not have any
name collisions.  

Domino Directory name collisions occur when the migration process uses an SDD entry to create
a  Domino Directory entry that cannot be distinguished from an existing Domino Directory entry.
Remember that the entries in your Domino Directory may represent Notes users or they may
represent users on other mail systems. Since you configured LCCOV/400 and set up Domino for
AS/400 directory synchronization in an earlier step, you should already have a person document
in the Domino Directory for each of your OV/400 users.

There are two types of name collisions that can occur when you migrate OV/400 users to Notes:

1. Full name collisions occur when the constructed full name created by DME/400 using the First
name, Last name and Middle initial is the same as another Domino Directory entry. In order
for Notes to work properly, full names must be unique within the Domino Directory.

2. Short name collisions occur when the short name created by DME/400 using the user ID is
the same as the Short name for another Domino Directory entry. In order for LCCOV/400 to
work properly, all short names for a mail domain in the Domino Directory must be unique.

Some name collisions are fine. For example, when you migrate an OV/400 user, his full name will
collide with the Domino Directory entry that was already created for him by Domino for AS/400
directory synchronization. Since the existing directory entry represents the same user (the user
you are in the process of migrating), this type of name collision is acceptable.

Other name collisions must be corrected.  For example, if the OV/400 user you are migrating has
a user ID that is the same as the short name for an existing Notes user that is a different person,
you must correct the collision before you can register the user to Notes.

You must plan for an appropriate amount of time and resource to resolve name collisions.  It is
best to resolve all name collisions for all users (even those not migrating to Notes at this time)
before migrating any users.

DME/400 can assist you in identifying full name and short name collisions. Name collisions are
handled through a process of identification and resolution during the migration load steps, which
are explained in detail in later sections.

5.1.1 About Mignames.nsf

The migration process uses a specialized version of a Domino Directory (also known as a Name
and Address Book)  to assist in the migration of users, groups, and public nicknames. This
specialized directory is called Mignames.nsf. Mignames.nsf is populated by the extract and load
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steps of migration.  You use the OV/400 extraction tool to extract entries from the SDD on your
OV/400 source system and then load the extracted entries into mignames.nsf on your target
DME/400 migration server.

Mignames.nsf has several roles during and after migration:

� During the initial migration load step, mignames.nsf is first used to resolve name collisions and
as a repository for information about the OV/400 users.  It contains person documents for the
users that are being migrated and the information in these person documents is used when you
register the users to Notes in a later step. At that time, the migrated users are listed in the
Domino Directory as Notes users.

� During the group load step, it holds information about OV/400 nicknames, and distribution
lists.  

� When migration is complete, mignames.nsf remains on your Domino server as a cascaded
name and address book that is used for resolution of migrated nicknames and distribution lists.

5.1.2 Selecting OV/400 users for loading

It is recommended that you perform the migration extract and load steps (which will create entries
in mignames.nsf) for all of the SDD entries that represent OV/400 users of the following types:

� migrating to Notes now
� will continue using OV/400 for some time and migrate later
� will not be migrated but need to exchange mail and share calendars with Notes users

Rather than working with all of your SDD entries at the same time, you should extract and load a
subset of your total user population at one time to simplify management of the load steps. When
you have finished resolving name collisions for the first subset, you can work with a different
subset, repeating the process until you have finished with all of your SDD entries. The subset
should be manageable and easily identified, such as all users in a certain department who are
enrolled in OV/400 on a particular AS/400 system.

The migration tools allow you to include or exclude appropriate SDD entries each time you
extract and load a set of entries.

Excluding SDD entries
Exclude entries by updating the LNM400/CONFIG.EXCLUDE member.  This member lists
specific SDD entries that should not be loaded.  This member is primed to exclude the Q* user ids
that are shipped with the AS/400 as well as *ANY entries.  For example, you could exclude
everyone in a specific department or exclude SDD entries that were created by directory
shadowing.  Add additional entries if needed.  Refer to IBM OV/400 Migration Tools database
(IBMTOOL4.NSF) for more information.

Including SDD entries
Include entries by updating the LNM400/CONFIG.INCLUDE member.  This member can be
used to select a subset of SDD entries by specifying search criteria.  For example, you could select
only one or two departments at a time, or you could select people within a certain location, etc.
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Add additional entries if needed.  Refer to IBM OV/400 Migration Tools database
(IBMTOOL4.NSF) for more information.

Examples
To exclude SDD entries that were created by AS/400 directory shadowing:

Assume you have three AS/400 systems, USA, JAPAN, and GERMANY, and you have AS/400
directory shadowing enabled.  All users on all systems will be in all three AS/400 system
distribution directories.  Suppose you are migrating the USA users to Domino first and want to
exclude the users shadowed from JAPAN and GERMANY.  To use the SDD on the USA system
and get only the USA users, you would specify the following in the INCLUDE member:

GROUPID = USA
USA.FIELD = SYSNAME
USA.SYSNAME = USA

Alternatively, you could specify the following in the EXCLUDE member:

SYSNAME = JAPAN
SYSNAME = GERMANY

In addition, if you want to migrate only the users in the CORPORATE department on the USA
system, you would use one of the above methods and also the following in the INCLUDE
member:

GROUPID = CORP
CORP.FIELD = DEPT
CORP.DEPT = CORPORATE

5.1.3 Extracting and loading users, distribution lists and nicknames

Once you have set up your include and exclude files to identify a subset of SDD entries, you will
perform the extract and load steps using the OV/400 extraction tool and DME/400. You will use  
mignames.nsf for several purposes:  

� Loading SDD entries
� Resolving full name collisions
� Resolving short name collisions 
� Migrating distribution lists and public nicknames

Before you actually migrate any users to notes, it is recommended that you extract and load all of
the SDD user entries, working on a subset at a time, resolving name collisions as needed.  

Once you have loaded and extracted all of the user entries and resolved all name collisions, you
will extract and load all of the public nicknames and distribution lists. For public nicknames and
distribution lists, the load step creates group entries in mignames.nsf that represent each public
nickname and distribution list.  In order to migrate distribution lists and nicknames from OV/400
for all users (even those who are not migrating at this time), you should extract and load all SDD
entries prior to registering any users to Notes and migrating their data.  This establishes  
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addressability to all remaining OV/400 users so that the group entries for distribution lists and
nicknames are loaded with the correct addresses. 

5.2 Using DME/400 to Identify and Resolve Name Collisions

You choose how DME/400 identifies name collisions and how name collisions will be handled.
Name collision processing should be chosen with the following goals in mind:

� All short names for a mail domain in the Domino Directory must be unique in order for
LCCOV/400 to work properly.

� Full names in the Domino Directory should be unique in order for Notes to work properly.

In order to achieve both goals, you should follow the steps below.  The steps are outlined here
and then the following sections provide more detail. You should refer to the documentation
provided with the OV/400 extraction tool and DME/400 for more complete information on using
the tools.  

Note: If you have already resolved name collisions using some other mechanism, you can skip
steps 3 through 6.

1. Set up the include and exclude members so that they properly identify the working subset of
SDD entries that you plan to extract and load at this time.

2. Use the OV/400 extraction tool directory load program to extract a subset of SDD entries
from your source OV/400 system

3. Use DME/400 to load the extracted entries into mignames.nsf, setting flags so that
preprocessing will catch collisions on full name.

4. Remove entries in mignames.nsf that were created during this stage if they did not cause a
name collision or if you’ve determined that the name collision is acceptable. 

A name collision is acceptable if the collision occurs with a directory entry that represents the
same user, probably an entry created by Domino for AS/400 directory synchronization. You
must remove these entries so that errors aren't received a second time when you use the
directory load program again in step 6. 

5. Correct full name collisions by updating the entry in the SDD on the source OV/400 system.

6. Rerun the OV/400 extraction tool directory load program on your source OV/400 system to
rebuild the file with the changed SDD entries.

7. Use DME/400 to load the extracted entries on your target Domino server again. You will set
different flags this time so that preprocessing will catch collisions on short name.

8. Resolve short name collisions by updating mignames.nsf or the Domino Directory.

9. Repeat steps 1-8 until all SDD entries have been loaded into mignames.nsf.

10. Use the OV/400 extraction tool directory load program to extract the distribution lists and
public nicknames on your source OV/400 system.
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11. Use DME/400 to load the distribution lists and public nicknames into mignames.nsf.

Step 1:    Selecting a subset of SDD entries

Update the LNM400/CONFIG.EXCLUDE and LNM400/CONFIG.INCLUDE members so that
the subset of entries you plan to work with is correctly selected. This will be referred to as the
“working subset” of SDD entries.

Step 2:    Extracting a subset of SDD entries 

1. Set up your OV/400 extraction tool configuration file members and do any other preparation
necessary for the OV/400 extraction tool.

2. Call lnm400/lnmmdir 'PERSONS' to extract your working subset of SDD entries.

Step 3:    Finding full name collisions 

In this step, you use DME/400 to load the extracted SDD entries and find full name collisions.
DME/400 refers to this as the User Name. 

1. Set the correct options in the source location document:

� Name Resolution flag =  Enabled

� Directory Migration Preprocessing flag = Enabled

� Name Collision Match flag = On User Name

� Name Collision Option for Registered Notes Users = Flag error if duplicate

� Name Collision Option for Other Person Documents = Flag error if duplicate

2. Use nmsload from the Domino for AS/400 console to load the SDD entries.  

After loading the SDD into mignames.nsf (run nmsload), one of the following status values
will be set in mignames.nsf for each SDD entry loaded:

� Preprocessing failed:  This status identifies person documents that had a collision or
multiple collisions on the “constructed full name.” A full name collision occurs if the value
Firstname MI. Lastname from one or more existing Domino Directory entries is the same
as the value of FSTNAM MI. LSTNAM from the SDD entry. The full name collision
could occur with either a registered Notes user or a user listed in the directory who is not
registered to Notes. If you are using Domino for AS/400 directory synchronization, most
of your entries will have this “failed” status because directory synchronization created a
Domino Directory entry for each of your OV/400 users.

� Not registered to Notes:  This status identifies person documents that didn't have any
collisions on the "constructed full name." 

You must determine the reason for failure for each of the users whose status is Preprocessing
failed. Correct the failure if necessary, and then reprocess the users.  
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To determine why a failure occurred, view the Event Log which is also located in
mignames.nsf. Examine the log data for the "Directory Import (NMSLOAD)" for the time
period when you loaded the entries (ran nmsload).  Each user loaded into mignames.nsf will
have a message that indicates the cause of the failure:

� MIGE0062 : Preprocessing for name <John W. Smith> found 0 Registered user name
matches and 1 unregistered name matches

This error was received because there is one person document in the Domino Directory
that represents someone who is not registered to Notes but has John W. Smith as the
constructed full name. The collision may have occurred with a person document that was
created by Domino for AS/400 directory synchronization and may represent the same
“John W. Smith” included in your working subset of SDD entries.

� MIGE0002 : Single name match found for <John W. Smith> but Name Collision option
set to 'Flag error if duplicate'

This error was received because there is one person document in the Domino Directory
that represents a registered Notes user who has John W. Smith as the constructed full
name. The Domino Directory entry may represent the same “John W. Smith” if you
previously registered the user to Notes and are now preparing to migrate his data.
Otherwise, this may represent a collision with a different “John W. Smith.”

� MIGE0062 : Preprocessing for name <John W. Smith> found 2 Registered user name
matches and 0 unregistered name matches

This error was received because there are two person documents in the Domino Directory
that represent registered Notes users with John W. Smith as the constructed full name.
Multiple collisions on person documents that represent registered or unregistered Notes
users will always yield an error.

� MIGE0062 : Preprocessing for name <John W. Smith> found 1 Registered user name
matches and 1 unregistered name matches

This error was received because there is one person document for a registered Notes user
and one person document for an unregistered Notes user that both have John W. Smith as
the constructed full name.  This is considered a multiple collision and will always flag an
error.

Step 4:    Removing acceptable entries from mignames.nsf

Find all user entries in the “working subset” (i.e., users that were loaded in this iteration of step 3)
that did not have collisions or that had acceptable collisions and remove them from mignames.nsf. 

1. Open the Candidates to Register view.  This view shows all users who did not have any full
name collisions. 

DELETE these person documents from mignames.nsf.  Delete only the person documents that
are part of your current working subset of SDD entries. You will reload the working subset in
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steps 6 and 7 to check for short name collisions.  Do not delete person documents that you
already loaded/migrated at a different time.

2. Open the Failed Preprocessing view and find all the person documents whose full name
collisions ARE desired.

In other words, determine if the name collision occurred with a Domino Directory entry that
represents the "same person." The Domino Directory entry may be for someone who is
already registered to Notes and you are now migrating their data, or the directory entry may
represent someone who is not registered to Notes. Perhaps it is an entry created earlier by
Domino for AS/400 directory synchronization for the same user and now you are migrating
the user to Notes.

DELETE the person document from mignames.nsf for all users whose collisions are
acceptable and expected.  Again, delete only the person documents that are part of your
current working subset of SDD entries. You will reload the working subset in steps 6 and 7 to
check for short name collisions.  Do not delete person documents that you already
loaded/migrated at a different time.

Step 5:    Correcting full name collisions

The only users left in mignames.nsf at this time should be those who have a full name collision
that is undesirable.  Correct these collisions as follows:

1. Update the SDD entry for each user (use the CHGDIRE command) so that the name will no
longer collide.

For example, if you had a collision on "John Smith," you could change the MIDNAM field in
his SDD entry to "W".  Ensure that your new changes will not cause an additional collision
either with another SDD entry or with another Domino Directory entry.

Since you set up Domino for AS/400 directory synchronization when you set up LCCOV/400,
any changes you make to the SDD are automatically synchronized to the corresponding
person document in your Domino Directory right away. The person document in the Domino
Directory will be updated again later when you register the user to Notes.  This is simply a
side effect of using both directory synchronization and DME/400 -- both products make
updates to the Domino Directory based on what they find in the SDD.

2. After you update the SDD entry, delete these users from mignames.nsf.  

When you have completed this step, all of the person documents that you loaded in step 3 should
be deleted from mignames.nsf so that they can be reloaded in steps 6 and 7.  

Step 6:    Extracting working subset of SDD entries again

Rerun the source location extraction tool directory load program to extract the same subset of
SDD entries again. That is, call lnm400/lnmmdir 'PERSONS'. This is necessary to pick up any
changes you made to the SDD entries in the previous step.
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Step 7:    Finding collisions on Short Name

Use DME/400 to load the extracted SDD entries and find collisions on short name.

1. Set the correct options in the source location document:

� Name Resolution flag =  Enabled

� Directory Migration Preprocessing flag = Enabled

� Name Collision Match flag = On Short Name

� Name Collision Option for Registered Notes Users = Flag error if duplicate

� Name Collision Option for Other Person Documents = Flag error if duplicate

2. Run nmsload from the Domino for AS/400 console to load the SDD entries.  

After loading the SDD into mignames.nsf, one of the following status values is set in
mignames.nsf for each SDD entry loaded:

� Not registered to Notes:  This status is given to all person documents that did not collide
on the short name (i.e., their short name is unique).

� Preprocessing failed:  This status is given to all person documents that had a collision or
multiple collisions on the short name.

Step 8:    Correcting short name collisions

Determine the reason for failure for all users in Preprocessing failed status. Correct the failure if
necessary, and then reprocess the users.  

To determine why a failure occurred, view the "Event Log" which is also located in mignames.nsf
and examine the log data for the "Directory Import (NMSLOAD)" for the time period when you
loaded the entries (ran nmsload).  Each user loaded into mignames will have a message indicating
why the failure occurred:

� MIGE0062 : Preprocessing for name <JSmith> found 0 Registered user name matches and 1
unregistered name matches

This error was received because there is one person document in the Domino Directory that
represents someone who is not registered to Notes that has JSmith as the short name.

� MIGE0002 : Single name match found for <JSmith> but Name Collision option set to 'Flag
error if duplicate'

This error was received because there is one person document in the Domino Directory that
represents a registered Notes user that has JSmith as the short name.

� MIGE0062 : Preprocessing for name <JSmith> found 2 Registered user name matches and 0
unregistered name matches
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This error was received because there are two person documents in the Domino Directory
that represent registered Notes users that have JSmith as the short name.  Note that multiple
collisions on registered or unregistered person documents will always yield an error.

� MIGE0062 : Preprocessing for name <JSmith> found 1 Registered user name matches and 1
unregistered name matches

This error was received because there is one person document for a registered Notes user and
one person document for an unregistered user that both have JSmith as the short name.  This
is considered a multiple collision and will always flag an error.

In order to correct short name collisions, do the following:

1. Open the Failed Preprocessing view and find all the person documents whose short name
collisions ARE desired.  In other words, determine if the name collision detected the "same
person". There are several possibilities:

� The person may be already registered to Notes and you are now migrating their data.

� The person may be listed in the Domino Directory, but not registered to Notes. Domino
for AS/400 directory synchronization may have created the entry and you are now
migrating the user to Notes.  

2. For each user whose collision is acceptable, click the "Accept" button.

These users will now be in Not registered to Notes status. 

3. Correct the short name collisions for users where the collision is not desirable. 

These are the remaining users in the Preprocessing failed status. The SDD entry for these
users has a user ID which collides with the short name of a different person listed in the
Domino Directory. Since short names must be unique for Notes users, these users will not be
able to use their current user ID as their short name for Notes. You should change the short
name for these users in mignames.nsf.  At this time, you are only changing the short name in
mignames.nsf and not in the SDD or in the Domino Directory, the change does not affect the
user or mail routing in any way. When you extract and load the distribution lists and public
nicknames in a later step, they will be updated to match the new short name for the user.

Note: Changing the short name in the Domino Directory for the other user is not
recommended.

Once you have changed the short name in mignames.nsf for each of these users, select all the
users and click the "Accept" button.  These users will now be in Not registered to Notes
status.

You have now resolved both full name collisions and short name collisions for all of the users in
your working subset of SDD entries. All of the users from your working subset should now be in
Not registered to Notes status.
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Step 9:    Repeating previous steps for each subset of SDD entries

Repeat steps 1 through 8  with a different working subset of SDD entries until you have selected
and loaded all of your SDD entries.

Step 10:    Extracting distribution lists and public nicknames

Use the OV/400 extraction tool to extract the distribution lists and public nicknames using the
source location extraction tool directory load program. That is, call lnm400/lnmmdir 'GROUPS.

Step 11:    Loading distribution lists and public nicknames

Load the distribution lists and public nicknames into mignames.nsf. That is, run nmsload on the
groups file.
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6.0 Migrating a Set of Users

At this point, you have resolved all name collisions.  Mignames.nsf should contain:

� an entry for each OV/400 user you are migrating,

� an entry for each OV/400 user that needs the capability to share calendar information with
Notes users, and 

� a group entry for each public nickname and distribution list being migrated.

Now you will begin moving a selected subset of users from OV/400 to Domino.  In most cases
you will not migrate all of your users at the same time. It is recommended that you complete
migrate a subset of users to Notes and then repeat the process for another set of users. The
process requires several steps:

1. Define how DME/400 should handle name collisions during migration

2. Suspend Domino for AS/400 directory synchronization

3. Register a set of OV/400 to Notes

At this stage, the user is known as a Notes user to other Notes users. However, the user is
still enrolled in OV/400 and therefore continues to be known as an OV/400 user to other
OV/400 users.

4. Migrate user data from OV/400 to Notes

5. Remove migrated users from OV/400

6. re-enable directory synchronization and populate directories

Once the SDD is updated by directory synchronization to reflect the fact that the user is now a
Notes user, mail from OV/400 users to this user will be directed to Notes and calendar
requests from OV/400 users will access the user’s Notes calendar using LCCOV/400.

Repeat the above steps for another subset of users until you have migrated all of the OV/400
users you wish to migrate to Notes.

6.1 Defining name collision handling during registration

You must set up the DME/400 options so that name collisions are handled properly during Notes
registration. 

Since you have verified that all constructed full name and short name collisions occur only with
Domino Directory entries that represent the same user, you should set the following options in the
source location document:

� Name Collision Option for Registered Notes Users = Use existing person document 

� Name Collision Option for Other Person Documents = Update if duplicate
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6.2 Suspending Directory Synchronization

As you have seen, the process of migrating and registering new Notes users involves both the
AS/400 and Domino directories.  The SDD has been used as the source directory for selecting
migration candidates.  The Domino Directory will be the "master directory" for your Notes users
after migration is complete, and it is also the directory that LCCOV/400 will use to find the
calendars for OV/400 and Notes users.  The SDD will continue to be the "master directory" used
by OV/400.  

As you have made changes to your Domino Directory and SDD entries in previous steps, the
changes have been synchronized between the directories by Domino for AS/400 directory
synchronization. At this time, you should suspend directory synchronization.  This allows you to
make the full set of updates to both directories that are necessary to completely migrate a set of
users and then to synchronize the changes in a controlled manner, ensuring that the Domino
Directory serves as the “master directory.” If you do not suspend directory synchronization, you
can have very undesirable results. It is possible that required updates to the Domino Directory can
be undone by outdated information in the SDD. 

To suspend directory synchronization, 

1. Open the Directory Sync Configuration database (NNDIRSYC.NSF).

2. Click Configurations.

3. Select the configuration document for the configuration that you want to suspend and click
Edit Configuration.

4. Change the status of the configuration to Suspended.

5. Click Save and Close.

Directory synchronization may take up to 5 minutes to end.

Note: When you suspend directory synchronization, changes made to either directory will not be
synchronized with the other directory until AS/400 directory synchronization is enabled and
changes are populated.  You should avoid making changes to the SDD while directory
synchronization is suspended because the changes may be lost when you populate the directories
after migration.

After you complete migration in a later step, you will be directed to re-enable directory
synchronization and to populate both directories using the Domino Directory as the master
directory.

6.3 Removing the OV/400 Calendar Domain for users who will migrate to Notes

When directory synchronization populated the OV/400 users to the Domino directory, the
CalendarDomain field in the person document was automatically filled in to reflect their AS/400
calendar domain name. For users who will be migrated from OV/400 to Notes, you will need to
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delete this AS/400 specific information in the CalendarDomain field so that OV/400 and Notes
users will be able to successfully view each other's calendars.

The CalendarDomain field can be removed either before or after registering the person to Lotus
Notes from the Domino Migration Engine (DME) Administration (MIGNAMES.NSF) Database.
If the CalendarDomain field is deleted after registering the OV/400 user to Notes, OV/400 users
and the migrated Lotus Notes users cannot successfully view each other's calendars until you run
the Lotus Notes server tasks described below.

You can remove the CalendarDomain field from the Person documents in the Public Name and
Address Book in one of the following ways.  You can copy and use a DME provided Agent,  you
can create and use your own agent, or you can manually delete the contents of the
CalendarDomain field.

The DME provides and Agent that will delete the contents of the CalendarDomain field.  Copy
the Agent "Remove Calendar Domain Field Value" from the DME Administration
(MIGNAMES.NSF) database to the Lotus Notes Public Name and Address Book.  To copy the
DME provided Agent:
� Open the MIGNAMES.NSF
� Click on the action View -> Agents
� Highlight the Agent "Remove Calendar Domain Field Value"
� Copy the Agent to the clipboard by selecting Edit->Copy or by pressing the Ctrl + Insert

keys
� Close the MIGNAMES.NSF database
� Open your Lotus Notes Public Name and Address Book
� Click on the action View -> Agents
� Paste the Agent into the Public Name and Address Book by selecting Edit->Paste or by

pressing the Shift + Insert keys
� You will be prompted on whether or not the agent should automatically be updated when

the template design is changed.  Click on No.
� The Agent should now be listed in the Agent view.  The Agent should be listed under the

action bar item Actions.  
� Follow the steps under "To use the Agent"

To manually create your own Agent, open the Lotus Notes Public Name and Address Book and
select Create->Agent....  Define the following in the agent you create:
� When should this agent run?  -  Manually From Actions Menu
� Which document(s) should it act on?  -  Selected documents
� What should this agent run?  -  Formula
� The Formula should have the following:

FIELD CalendarDomain := "";
CalendarDomain

� Follow the steps under "To use the Agent"
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To manually delete the contents of the CalendarDomain field:
� Select, open and edit the Person document for each OV/400 user that you will be

registering
� Delete the contents of the CalendarDomain field
� Save and close the Person document

To use the Agent
� Select the OV/400 users that you will be registering to Lotus Notes.  Note:  This will still

be a manual selection, but the agent will save you time since you will not have to manually
open and edit each individual Person document

� To run the Agent, click on the action Actions -> Remove Calendar Domain Field
Value.

� When the agent has completed running, the contents of the CalendarDomain field value
will be deleted from all selected person(s) documents

If the contents of the CalendarDomain field are not deleted prior to registration, delete the
contents of the CalendarDomain field as described above and run the DESIGN and UPDALL
server tasks from the Lotus Notes Server console.  (You must run the server tasks DESIGN and
UPDALL from a Lotus Notes Administrator ID.)  You can either run these server tasks manually
or wait for the server tasks to run at their scheduled times, but until the tasks run your OV/400
and migrated Lotus Notes users will not be able to access each other's calendars when using
LCCOV/400.

6.4 Registering OV/400 users to Notes

Register a selected subset of the OV/400 users as Notes users using DME/400:  

1. Open the Candidates to Register view and select the person document for each person you
want to register to Notes. 

2. Click Register.

DME/400 will attempt to register each selected user to Notes. One of the following status
values is expected for each person document when the registration step completes:

� Notes Registration Finished:  Indicates that the registration completed successfully.

� Notes Registration Failed:  The most common cause for a Notes registration failure is
that the hierarchical name that is being given to the user conflicts with an
already-registered Notes user. Correct the failed registrations by making a change to
mignames.nsf. (All users in Notes Registration Failed status can also be found under the
Failed Registration view.)  

Two common problems and corrections are:

� You are registering John Smith/Acme and even though you found no collisions on
constructed full name or short name during the migration load step, there is already a
person document in the Domino Directory with John Smith/Acme in the FullName
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field.  To correct this problem, open the Failed Registration view, select the person
document, and change a value such as the middle initial, accept the user, and then
reregister the user.  A new Domino Directory entry will be created for the user being
registered.

� You are registering Jane Smith/Acme who is already listed in the Domino Directory
with a short name that is different than the short name in mignames.nsf.  During the
migration load step, you may have found an acceptable collision on constructed full
name, but no collision on short name.  Registration fails when you attempt to register
Jane Smith/Acme because there is already a person document with that full name, but
a different short name.  To correct this problem, open the  Failed Registration view
and select the person document, change the short name value in mignames.nsf to
match the short name in the Domino Directory, accept the user, and then reregister the
user.  The user will be registered using the existing Domino Directory entry. 

6.5 Migrating Data from OV/400

In this step, you migrate mail, calendar, etc. from OV/400 to Notes for the newly registered Notes
users.  

Use the OV/400 extraction tool to specify what data should be collected by changing the
LNM400/CONFIG.LNM400 member.  You can specify the types of OV/400 data to be migrated
(i.e.,  mail, calendar, private nicknames, folders, etc.) and the cutoff dates for each.  

Refer to the Domino Migration Engine Install database (LMTKINST.NSF) for more
information.

6.6 Removing OV/400 Enrollment for migrated users

To fully migrate the users to Notes, you must remove their OV/400 enrollment. This is necessary
so that Domino for AS/400 directory synchronization can successfully update the SDD entry in
the next step to indicate that this is now a Notes user. Otherwise, OV/400 users will continue to
direct mail to the OV/400 user. Also, if the user is still enrolled in OV/400, LCCOV/400 will not
work correctly for this user. That is, OV/400 users will continue to access the user’s OV/400
calendar rather than the Notes calendar.

Use the Remove Office Enrollment (RMVOFCENR) command on any AS/400 command line to
remove the user from OV/400.   You must specify *DLT in order for the user to be successfully
removed from OV/400.  If *NODLT is specified and the user owns OV/400-related objects, the
user is not removed from OV/400.  

When a user is removed from OV/400, the AS/400 user profile still exists along with folders,
documents, and other OS/400 objects that are owned by this user. The user's OV/400 calendar is
deleted. The user still exists in OV/400 distribution lists and nicknames, and can still access
OV/400 documents as follows: 
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� The user can do functions such as the following:  CPYDOC, DLTDLO, RNMDLO,
PRTDOC (only to a printer or output file), WRKDOC (only copy, delete, and rename)

� The user cannot do functions such as the following:  DSPDOC, EDTDOC, MRGDOC,
PRTDOC to the display, CRTDOC

Until the SDD entry for the user is updated in the next step by Domino for AS/400 directory
synchronization, LCCOV/400 will not try to use the Notes calendar of the new Notes user. At
this stage, if an OV/400 user attempts to look at the calendar for the new Notes user, they will
receive a message indicating that the user is not enrolled in OV/400. 

Note: Do not attempt to update the SDD entry manually for the newly migrated users!  The next
step will update the SDD so that the user is recognized as a Notes user. 

6.7 Re-enabling Directory Synchronization 

At this time, you must re-enable Domino for AS/400 directory synchronization and populate both
directories using the Domino Directory as the master directory.

When you re-enable directory synchronization, the SDD entries for the migrated users are
updated so that OV/400 mail will be directed to the users' Notes mailbox and so that OV/400
users can access the users’ Notes calendars with LCCOV/400.

The steps necessary to re-enable directory synchronization and populate the directories are listed
below. The directory synchronization configuration options are the same as those that you were
directed to use when you set up LCCOV/400. The options are repeated here so that you can
verify that your configuration is correct. 

Important Note:  Directory synchronization uses RNMDIRE for the SDDs that were
migrated from OV/400 to Notes to change the address portion of the SDD to reflect the
Domino domain name.  This rename function also updates the AS/400 distribution lists and  
nicknames with the users new mail address.  In order for RNMDIRE to complete successfully,
there should be no DIA activity and there cannot be any locks on the objects that the rename
process must access.  You can refer to the SNA Distribution Services (SC41-5410) book for
specifics about the system requirements for RNMDIRE to complete.  Before you re-enable
directory synchronization, it is recommended that you end the following system tasks:

ENDSBS QSNADS

ENDSBS QSERVER

ENDMSF

ENDTCPSVR (*POP *FTP *SMTP)

On the console of Domino server where LCCOV/400 is installed:

TELL LCCOV STOP ASMON
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If the rename does not complete, OV/400 users will not be able to access information on the
migrated users Notes calendar.  You can manually use the RNMDIRE command at a later
time to update the SDD to reflect the address for the Domino domain.  

1. Open the Directory Sync Configuration database (NNDIRSYC.NSF) on the Domino server
from your Notes desktop .

2. Click Configurations.

3. Select the configuration document that is currently suspended and click Edit Configuration.

4. Choose a synchronization type of Bi-directional and a status of Enabled. Click Next.

5. Choose Yes for the Populate Directories option.

6. Select the Domino address book as the master directory. The master directory is used first to
populate the other directory.

7. Choose when the populate operation should be done; either immediately or on a specific day
and time.

You should choose a time when system activity can be restricted. If directory synchronization
is unable to get a lock on the SDD entries, the updates will fail.

Click Next.

8. A panel for configuring the AS/400-to-Domino synchronization is displayed. 

You will probably want to keep the field and key mappings as they are. Click Next.

9. A panel for configuring the Domino-to-AS/400 field mappings is displayed. 

You will probably want to keep the field and key mappings as they are. Click Next.

10. Specify "Yes",  mail addressing information should be automatically synchronized. 

� Select the Domino Public Address Book as the master mail directory.

This will ensure that the mail information in the Domino Directory will take precedence
over the SDD entry during the repopulating. When changes are made to either of the
directory entries at a later time, the changed information replaces the mail information in
the synchronized directory entry, regardless of which directory is the master mail
directory.

� Specify that existing AS/400 SMTP addresses should not be mapped during populate.

� Specify that existing AS/400 SMTP addresses should be maintained.

When you are finished, Click Next.

11. Type the following in the Advanced Options field:

NAMESTYLE=LCCOV
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This will cause directory synchronization to use a naming style which is optimized for use with
LCCOV/400.

When you are finished, Click Next.

12. When you see the completion panel, click Save and Close.

At the time you specified, directory synchronization will begin to populate the  Notes user
entries from the Domino Directory to the SDD and the OV/400 user entries from the SDD to
the Domino Directory.

13. Allow repopulation of the directories to complete 

When Domino for AS/400 directory synchronization completes the requested populate of the
directories, the migrated user entries will have been updated to work properly with
LCCOV/400. Examine the Directory Synchronization Log database (NNDILOG.NSF) on the
server to determine the status of the population request and ensure it is complete.

After directory synchronization is complete (and AS/400 directory shadowing has run if OV/400
was used on a remote system), mail exchange and calendar sharing should work as follows:

� Mail from OV/400 will now be forwarded to the user's Notes mail. 

� OV/400 users can access the user's Notes calendar with LCCOV/400, rather than the OV/400
calendar that was deleted.

Note: There may be entries in your SDD that should not be synchronized.  You can use directory
synchronization selection criteria to limit the entries that are updated.  

6.8 Miscellaneous Considerations

6.8.1 If you did not remove OV/400 enrollment

You may have neglected to remove a user from OV/400 (so that the user is still enrolled in
OV/400 and also registered to Notes). If this is the case, then once you re-enable directory
synchronization, this user will be handled as follows:

� Mail from OV/400 will be forwarded to the user's Notes mail. 

� The user has both an OV/400 calendar and a Notes calendar. Notes users will see the Notes
calendar and OV/400 users will see the OV/400 calendar.  Meeting notices will be forwarded
to the user's Notes mail.

If you decide to remove the user’s OV/400 enrollment  at a later time, you must:

� Follow the steps described earlier to remove OV/400 enrollment for the migrated user 

� Force Domino for AS/400 directory synchronization to update the SDD entry for the user so
that OV/400 users can access the user’s Notes calendar with LCCOV/400. You can either:

1. Rerun the directory synchronization populate step, or
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2. Edit the user's person document in the Domino Directory while directory synchronization
is active.

Caution: do not attempt to update the user's SDD entry directly using either the Work with
Directory Entry (WRKDIRE) command or Change Directory Entry (CHGDIRE) command
because incorrect results can occur.

6.8.2 Updating the LCCOV/400 Configuration

As you migrate users to Notes, you may find that you need to update the LCCOV/400
configuration. For example, this will be necessary if you migrate users to Domino mail domains
that did not exist when you first set up LCCOV/400. See the Installing and Managing
LCCOV/400 database (LC400DOC.NSF) for more information about modifying the
configuration.
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